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1. Overview: CityGRID® Scout 
The CityGRID® Scout is the 3D visualization module of the CityGRID® product line and serves as display format for 
interactive 3D virtual reality projects. Based on the Unity - 3D Gaming Engine (https://unity3d.com/de/unity) the 
Scout is capable of presenting 3D scenes offline and online. The trendsetting Unity Gaming Engine enables analysis 
such as shadows or collision as well as general information queries. The connection with mobile devices (tablet 
and mobile phone) through their own apps is implemented and equally the linking to VR - glasses (Oculus Rift and 
HTC Vive). 

 

 

https://unity3d.com/de/unity
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2. Starting a CityGRID® Scout 
The CityGRID® Scout is the visualization software of the CityGRID® software suite. Scout projects offer an 
interactive and free navigation and allow viewing the project from every possible angle. The 3D scenes require a 
special data structure for a performant representation, which is provided by the CityGRID® Builder Control Center 
(see Manual of the CityGRID® Builder). An installed Scout project can be opened via the Windows Start menu. 

2.1. Opening optimized Scout projects 
When a Scout project has been optimized in the Builder, the project will be physically 
produced in the “Scout” - folder of the Builder’s project-directory. It contains the file 
"Scout.exe" through which the Scout gets started. 

 

Note: When Scout projects are opened through the Scout.exe file, an already installed 
Scout instance is a precondition as long as the Scout has not been published (see 

Manual of the CityGRID® Builder.). Furthermore, this instance must have access to 
the CodeMeter system of CityGRID® and must be able to obtain a free network license 

of the Scout. 

Scout projects that should provide access to a wider audience can be “published” in the Builder Control Center 
(cf. Manual of the CityGRID® Builder). These Scout projects differ from non-published projects by the fact that all 
the necessary program data of the CityGRID® Scout are attached to the project data and can thus be operated 
autonomously. 

 

Note: The direct opening of files such as CityGRID® XML or CityGML is currently not possible in the Scout. 

Any form of data needs to be optimized for the Scout in advance by the Builder Control Center. 

 

When starting a Scout, a start screen opens initially. At this point, some display options and control options of the 
3D project can be set. 

 
• Resolution: 
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Defines the resolution of the Scout. If the window mode is enabled, the Scout will work in this window 
mode, otherwise in the fullscreen mode. 

• Quality: 
Defines the representation of the of 3D contents in the Scout, such as the sight distance, shadows, texture 
quality. 

• Language: 
Regulates the language of the Scout Menu. German, English and Turkish are currently supported. The 
proposed language is determined by the operating system. 

• Scout Server: 
Contains the path to the local Scout or the URL to the Scout Web Server. If no path is specified, an empty 
scout project is opened. 

Clicking the tab  starts the Scout. 

 

Note: If several different Scout projects shell operate at the same time, a selection menu can be created on 

the base of which the Scouts can be started. Contact UVM Systems for support of a corresponding 

installation. 
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3. Controlling a Scout Project 
The CityGRID® Scout can be displayed on different devices and accordingly different are the control options. 
Depending on the terminal and the existing equipment, the following control options are available. 

3.1. Keyboard 
Operating a Scout Project with the keyboard follows a WASD control, as common in 3D games. The following keys 
are reserved by default: 

Moving 

 Moving forward 

 Moving backward  

 Moving left 

 Moving right 

 Vertical rise 

 Vertical drop 

 Increase movement speed 

 Decrease movement speed 

 Direction of view up  

 Direction of view down 

 Direction of view left 

 Direction of view right 

 

Function Keys 

 Open / Close quick help 

 Open / Close menu 

 Hide / Show overview map 

 Hide / Show control console 

 Switch between variants 

 Change predefined transparent data packets 

 Enable / Disable double-sided surface representation 

 Change light settings 

 Change camera mode 

 Change collision detection 

 Enable camera animations 
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 Call viewpoints 

 

Menu Navigation 

 Open / Close menu 

 Menu item up 

 Menu item down 

 Menu level down / Select submenu 

 Menu level up  

 

Miscellaneous 

 Change season of trees 

 Close Scout 

 Enable / Disable Microsoft Kinect 

3.2. Mouse 
Operating the CityGRID® Scout is usually done by using the mouse as this control mode enables the application of 
most operations. Depending on the selected camera mode, the controlling varies and is optimized for certain 
investigations of the model. The following operating modes are currently available for mouse control. 

 

Note: The mouse has both tasks, to execute a movement in the 3D scene and to allow the interacting with 
the menu or the edge equipment of the Scout (e.g. the overview map.). Movements without a pressed mouse 

button never affect the 3D contents, but only move the mouse cursor. To vary the 3D cutout, the mouse 

button must be held down. 

 

Note:  The airspeed is always depending on the altitude above a terrain model. The higher the position above 

it, the higher the airspeed. When approaching the area, the speed reduces automatically. 

 

tip: Most settings of the camera modes, such as altitude, takeoff speed, etc. can be regulated via the "Config" 

page of the Builder Control Center. (See Manual of the CityGRID® Builder) 
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3.2.1. Automatic Mode     
Automatic mode is a mixture between helicopter mode and map mode. The flight altitude always remains constant 
when moving with the left mouse button. During a flight, all viewing directions can be taken freely. In this mode, 
collision detection is activated by default for all objects.  The WASD keys or the arrow keys activate the drone flight, 
while the altitude remains constant. 

 Move Rotation Altitude/Speed 

 
The 3D scene is moved by pressing 
the left mouse button and 
simultaneously moving the mouse 
(click-drag movement).  

By pressing the right mouse button 
and moving the mouse at the same 
time, the section is rotated at the 
current location, without moving 
forward or changing the height. 
  

Scrolling the mouse wheel zooms 
the scene. 

 

3.2.2. Focus Mode   
In Focus mode, a building is selected, which then becomes the focus and pivot point of the scene. Moving through 
the scene is only possible if another building is selected, which becomes the new focus point.  
 Move Rotation Altitude/Speed 

 
The pressed Ctrl key and left 
mouse button selects a CityGRID 
building in the scene and creates a 
focus point. 

Holding down the right mouse 
button and moving the mouse at 
the same time causes a rotation at 
the current location, without 
forward movement or height 
change. 

Rolling the mouse wheel zooms the 
scene. 

3.2.3. Teleport Mode   
Teleport mode was created specifically for VR applications to prevent motion sickness. 

 Move Rotation Altitude/Speed 
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Clicking the left mouse button on 
the terrain will jump in that 
direction. In this mode, this is the 
only way to move. 

Holding down the right mouse 
button and moving the mouse at 
the same time will cause a rotation 
at the current location, without 
forward movement or height 
change. 

Rolling the mouse wheel changes 
the height of the viewpoint. 

3.2.4. Helicopter Mode   
The helicopter mode imitates a drone flight. The altitude remains constant while moving through the 3D world. 
During the flight, all viewpoints can be taken freely. In this mode, the collision detection for all objects is enabled 
by default. 

 Move Rotation Altitude/Speed 

 
The left mouse button is held down 
to fly in viewing direction. Moving 
the mouse while holding down the 
left mouse button changes the 
flight direction, but not the altitude. 

Holding down the right mouse 
button while moving the mouse 
simultaneously results in turning 
around at the current position, 
without moving forward or 
changing the altitude.  

By pressing the mouse wheel and 
moving the mouse forward or 
backward, the altitude can be 
regulated. 

Rolling the mouse wheel causes 
acceleration / deceleration of all 
flight movements. 

3.2.5. 2D Mode 2D  
The 2D mode allows an overview of the scene in 2D and controlled movement without rotation around the Z-axis. 

 Move Rotation Altitude/Speed 

 
The left mouse button moves the 
scene.  

Holding down the right mouse 
button and moving the mouse at 
the same time causes a rotation at 
the current location, without 

Rolling the mouse wheel zooms the 
scene. 
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forward movement or height 
change.  

3.2.6. Walking Mode  
The walking mode shifts the current focus to a pedestrian position at an eye level of 1.8m as default value. 
Locomotion happens with this consistent preset level above the ground and results in a terrain-following mode 
whereby the 3D scene can be viewed from the pedestrian perspective. If necessary, the altitude can be adapted 
by the user. In this mode, the collision detection for all objects is enabled by default. 

 Move Rotation Altitude/Speed 

 
The left mouse button is held down 
to move in viewing direction. The 
altitude follows the ground surface 
and keeps the preset distance 
constant. 

Holding down the right mouse 
button while moving the mouse 
simultaneously results in turning 
around at the current position, 
without moving forward or 
changing the altitude. 

By pressing the mouse wheel and 
moving the mouse forward or 
backward, the altitude can be 
regulated. 

Rolling the mouse wheel causes 
acceleration / deceleration of all 
movements. 

3.2.7. Aircraft Mode  
The aircraft mode imitates a simplified aircraft control and allows varying altitudes by intentionally pulling or 
pushing the line of sight. The flight direction is always oriented in direction of the current screen-center. Thus, a 
continuous change of altitude occurs while moving forward if the flight direction is not perfectly horizontal. Hence, 
in this mode it is not possible to look toward the ground / sky without simultaneously moving in this direction. In 
this mode, the collision detection for all objects is disabled by default. 

 Move Rotation Altitude/Speed 

 
The left mouse button is held down 
to fly in viewing direction. The 
altitude adjusts continuously and 
orients itself toward the current 
screen-center. 

Holding down the right mouse 
button while moving the mouse 
simultaneously results in turning 
around at the current position 
without moving forward or 
changing the altitude. 

By pressing the mouse wheel and 
moving the mouse forward or 
backward, the altitude can be 
regulated. 

Rolling the mouse wheel causes 
acceleration / deceleration of all 
flight movements. 



 

 Manual CityGRID® Scout - Page 12 

 

CityGRID® 

       Scout 

 

3.2.8. Map Mode   
In the map mode, the control is based on the model of internet maps. Through clicking and simultaneously pulling 
or pushing a certain section into a desired direction, the shown section will be adapted. The speed of movement 
depends on the intensity of the mouse movement. In this mode, it is possible to perform very fine movements and 
a micro-control as it is advantageous for the inspection of objects. The altitude remains constant at every 
movement and changes only by a corresponding action of the user. In this mode, the collision detection for all 
objects is enabled by default. 

 Move Rotation Altitude/Speed 

 
Moving the 3D section happens by 
pressing the left mouse button 
while moving the mouse 
simultaneously (click - drag 
gesture). The process might be 
optionally repeated several times 
for the bridging of greater 
distances. The strength of the 
displacement is depending on the 
preset airspeed. 

Holding down the right mouse 
button while moving the mouse 
simultaneously results in turning 
around at the current position 
without moving forward or 
changing the altitude. 

By pressing the mouse wheel and 
moving the mouse forward or 
backward, the altitude can be 
regulated. 

Rolling the mouse wheel affects 
the strength of the shift of the 3D 
cutout together with a click-drag 
gesture with the left mouse button. 
The slower the movement is set, 
the finer the navigation can be 
done. 
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3.3. Control Panel 
To depict the operation of the Scout clearly, there is a control panel in the bottom right corner. This allows the free 
navigation in the 3D scene by clicking the appropriate button. In addition to the movement, the control panel 
provides options to change or call up the collision detection, the camera mode, the airspeed and the quick help. 
These options affect all control options. 

 

 

 

 

 

 

  
Collision detection 

Quick Info Distance 
measurement 

Sight up 

Sight down 

Compass 

Movement direction  
Quick help 

Increase speed 

Decrease speed 

Camera mode 

Climb 

Drop 

Turn right 

Turn left 

Pursuit mode 

Time Control 

Zoom Extents  
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3.4. Gamepad (XBox 360 Controller) 
Beside the mouse, the XBox 360 gamepad can be used to control the CityGRID® Scout. Particularly in connection 
with VR glasses (Oculus Rift or HTC Vive) the controller serves to perform a forward movement. 

The following figure shows the standard key assignment on the XBox 360 Controller. The XBox 360 Controller (for 
Windows) is currently the only gamepad supported by the CityGRID® Scout. 

 

 Move Rotation Altitude/Speed 

 
 

 

Note: The mouse has both tasks, to execute a movement in the 3D scene and to allow the interaction with 

the menu or the edge equipment of the Scout (e.g. an overview map). Movements without a pressed button 
never affect the 3D contents, but only move the mouse pointer. To vary the 3D cutout, the mouse button 

must be held down. 

 

 

 

Note: The presented camera modes under 3.2 are not available for the controlling with the gamepad, the 

controlling with the gamepad acts identical for each camera mode. 
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3.5. VR Glasses and Gamepad 
The CityGRID® Scout can be used with the VR glasses Oculus Rift and HTC Vive. The 3D scene fades into the VR 
glasses, giving the impression of being right inside the VR-world (immersive virtual reality). Every movement of the 
glasses is directly transmitted to the Scout as a change of direction. Consequently, it’s the user who determines 
the viewing direction in the Scout by rotation of the head or rotation of the body on the spot. 

 

Tip: For inexperienced VR users, it is advised to take a seat on a swivel chair and to execute the rotations in 

a sitting position! Experienced users can navigate through the Scout scene in a standing position. 

The gamepad takes on the movement as well as the interaction with the control devices of the Scout. Given that 
the view of this device is not possible while wearing the glasses, a user should make himself familiar with the 
controlling before dipping into the 3D scene! 

 

Note: In order to operate a Scout with VR glasses, the Scout must be started via the corresponding .exe file 

(Scout_Rift.exe or Scout_Vive.exe). This file can be generated via the Builder Control Center in the course of 
publishing (see Manual of the CityGRID® Builder) if VR Scouts are licensed under CityGRID®. In addition to 

that the setup of the glasses on the computer must be completed and its correct operating therefore 

guaranteed! 

 

 Move Rotation Altitude/Speed 

 
The movement in the Scout is 
always oriented towards the center 
of the current 3D section and the 
altitude remains constant. To 
prevent or minimize the possible 
feeling of dizziness while wearing 
the glasses (Motion Sickness) 
lateral flight movements are 
disabled. A reverse flight, however, 
is permitted and occurs against the 
current viewing direction. 

The viewing direction of the 3D 
scene depends on the 3D position 
of the VR glasses. Rotations 
towards all three axial directions 
are permitted and they can be 
combined with each other. To 
perform a complete rotation, the 
player himself must conduct a 
proper rotation on the spot. Simply 
by turning the head, it is not 
possible to look in all directions. 

Changes of the altitude are 
achieved by pressing the two 
trigger buttons. In this case, the 
change of altitude happens 
infinitely as long as one button is 
held down. 

Using the shoulder buttons offers 
an increase or decrease of the 
speed of the movements. 
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3.6. Gesture Control via Microsoft Kinect 
To facilitate the interaction with the Scout, without having to use peripherals like mouse, keyboard, etc., the 
CityGRID® Scout is connected to the Microsoft Kinect gesture control system. Here, control signals are transmitted 
through preset gestures. The Kinect detects the position of the arms in the space and converts the movements into 
control signals for the Scout. Each CityGRID® Scout is prepared for a Microsoft Kinect gesture control 2.0. 

 

Note: Every published Scout can be controlled with a Microsoft Kinect, no special facility or CityGRID® license 

is necessary. The only requirement is the correct installation of the Kinect. 

The implemented movement scheme uses an imaginary steering wheel. Like driving a vehicle, both hands must 
remain on the imaginary steering wheel in order that the Kinect-controlling works. As soon as at least one player is 
in the search field of the Kinect and the Kinect can detect the position of both hands, that person is declared the 
active player and the Scout hands over the control. If several people are in the visual field, there is still only one of 
them considered an active player and all the others are ignored by the Kinect. But it is possible to hand the control 
over to another player when the active player hides his hands in front of the Kinect. This can be done by putting the 
hands into the trouser pockets or place them behind the back. 

 

Tip: By default, the Kinect expects the active player at a distance of about 2 meters from the sensor. Once 

the sensor has detected the person, the person is allowed to move further away from the sensor. 

The Scout indicates the search field and the players located in it in a schematic representation below the 
general map icon. Once the Scout detects a Kinect-system, this image appears. The active player is 
indicated as a green dot, all remaining people as red dots. As shown through this representation it is 
always clear who has just taken control, and where this player is moving within the search field. 

 
Note: The control signals of the Kinect can always be (de-)activated by pressing the  button. When the 

Kinect is aligned, but disabled right now, the representation of the search field is shown grayed out. 
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The following gestures are currently stored: 

Triggering the tracking 

In order that the Kinect system can interpret the commands of the user, the active 
player must be identified. This is done by taking the starting position. Both hands 
are easily bent and put in front of the chest. Then clench a fist and imitate the 
position as if holding a steering wheel.  

 
Changing the sight 

Once the tracking is completed, the position of both hands must be changed as if 
rotating the steering wheel. Turning the steering wheel changes the viewpoint in the 
Scout accordingly. The distance between the two hands should remain constant. 

Raising the steering wheel towards the head increases the flight altitude. Lowering 
the steering wheel in direction of the waist decreases the altitude. When the 
steering wheel is kept at chest level, there is no change of altitude. 

 
Changing the airspeed 

The airspeed depends on the distance of both hands from the chest of the user.  

Moving the hands away from the body increases the speed. Approaching the hands 
decreases the speed. 

The movement can be completely stopped near the chest, so that a rotation on the 
spot is possible. 

If you move your hands even closer to the body, a backward movement starts. 

 

3.7. Control on Mobile Devices 
The CityGRID® Scout is available as app for mobile devices like cell phones and tablets. To support the smooth 
operation scheme of using touch screen input, the Scout also provides corresponding input commands. 

 

Note: To provide Scouts using the Scout app, please feel free to contact UVM Systems GmbH. 

The menu, as well as its sub-items are accessible with a single tap of a finger. It should be noted that not every 
menu item that is available in the offline mode is also available in mobile versions. In particular functions that need 
a following saving (e.g. the recording of a path) are not available. 
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 Move Rotation Altitude 

 
The movement in the Scout largely 
follows the card mode (see. 3.2.8). 
Locomotion in the 3D world 
happens by touching the screen 
with a finger and pulling the section 
in the favored direction. 

For a rotation, two fingers need to 
be put on the screen side by side 
and the section can then be turned 
in the favored direction. 

A change of altitude is performed 
by placing three fingers next to 
each other and shifting the picture 
content vertically. 

A variation of the speed is not 
provided on mobile devices. 
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4. Overview map 
To simplify the navigation over larger areas and to enable the positioning over selected local 
sites, the CityGRID® Scout is equipped with the function of an overview map. The map window, 
located in the upper right corner of the 3D window, can be folded (default value) or unfolded via 
the Builder Control Center right at the start of the CityGRID® Scout (see Manual of the CityGRID® 
Builder). The map window pops up by clicking on the map icon or is minimized by pressing the 

  Button. 

The contents of the map section are linked to the 3D position of the Scout. The indication of the position reference 
system in the Builder Control Center is obligatory so that the map is perfectly synchronized with the Scout data.  

 

Note: If the coordinates of the input data have been modified by attaching a local offset such that no EPSG 

code can be assigned, the overview map cannot be applied. In this case, the input data with the 

corresponding offset values are to be shifted before they are introduced into the Builder Control Center, 

By default, the map contents are integrated as Open Street Map WMTS service. 
This assumes that a working internet connection is guaranteed at the runtime of 
the Scout and that no firewall prevents the download of the required map section. 
The conversion of the projected coordinates into geographic coordinates as well 
happens via internet connection. In addition to the OSM data all other map data 
that are available as WMTS service can be used. This also applies particularly to 
basic city maps. The display of offline map data is equally possible and 
customized cards can be used. 

 

Note: However, when using offline map data an internet connection is still necessary, because the 

conversion of the configured local coordinates into geographic coordinates is achieved via a Web service! 

 

Note: To install an alternative map, please contact your UVM Systems supervisor. 

The current position in the 3D environment as well as the viewing direction are represented by the direction 
indicator. The zoom level within the map display can be zoomed in and out in the map window by using the mouse 
wheel. Moving map sections is possible by clicking and dragging. A double-click in the map view defines a new 
position and places the view of the 3D window exactly above this new position. 

 

tip: If you want to look at a very certain point on the map, the new selected position should be slightly off 

this point because the 3D view is kept exactly where the double-click was set. For a panorama view 

however, the new position is to be defined precisely at the selected point. 
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5. Main Menu 

Various actions and queries in the 3D scene can be made via the main menu. The button opens the menu. 
Navigation is possible via mouse, keyboard and gamepad. The following items of the menu are optional, and they 
will only appear if the Scout has the appropriate data available. 

5.1. Views 
Under the menu item “Views” all preset views of the Scout are callable. These can be static views or dynamic 
camera animations. 

5.1.1. Viewpoints 
Viewpoints are fixed predefined visual foci in the 3D scene that quickly bring into focus specific 
contents. Each Scout starts with at least one view which determines the starting viewpoint. If 
required, any number of views can be defined directly out of the Scout (see 5.3.4) or predefined 
via the Builder Control Center (see Manual of the CityGRID® Builder). 

 

Note: Viewpoints out of running Scouts can only be created in offline Scouts. Online Scouts do not allow a 

saving of the view and therefore can only head for predefined viewpoints. 

5.1.2. Animations 
Unlike viewpoints, animations are moving camera flights by the Scout. These flights have a 
preset speed and flight direction and qualify for putting the Scout into a kind of movie mode. 
The flights are defined by the 3D Studio Builder (see the Manual of the CityGRID® Builder) or 
directly in the Scout (see 5.3.4). When a flight is started, the viewing direction can be influenced 
individually (right mouse button, cursor keys etc.), but as soon as the individual control is 
completed the animation returns to the preset viewing direction. 

The animations start together with the Scout and run steady in the background. By activating an animation via the 

menu or the   button, the view jumps right to the current position of the ongoing animation and continues with 

this view until a new view is selected via the menu or the   button. By leaving the animation it is not stopped 
but proceeds the prescribed flight path in the blanked state. Each Scout can have any number of animations, but 
only one animation can be active at a time! 

 

tip: An existing animation can be started via the Builder Control Center after a specified period of inactivity 
in the Scout. This option can be enabled via the Config page of the Build tab (see Manual of the CityGRID® 

Builder). 

5.2. Content 
Content summarizes all the menu items that can change the appearance of the 3D scene. The listed entries must 
already have been prepared by the Builder Control Center at the time of preparation of the Scout. Via this submenu, 
the data combinations can be called up in real time. 

5.2.1. Variants 
To be able to switch between different (planning) states in the 3D scene in real time, so-called 
variants can be called up. These variants include various distinct states of the represented 
data, like planned construction projects, architectural designs, thematically mapped building 
models, etc. Each variant has been considered in the preparation of the Scout and is 
accordingly configured (see Manual of the CityGRID® Builder) so that an easygoing switchover 
at the runtime of the Scout is possible without complex calculations. Each variant holds a freely selectable name. 
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5.2.2. Transparencies 
Similar to the variants data packets, such packets can also be combined in the case of 
transparencies, but with the difference that the data contents remain the same (3D geometry) 
and only the transparency changes. With this mechanism, a building with interior design can 
for example be represented in such a way that the outer walls seem transparent or completely 
hidden to provide an entire free view into the interior. Analogous to the variants, the transparent 
data must be predefined via the Builder Control Center. A switching between the prepared states can then happen 
in real time at the runtime of the Scout. 

5.2.3. Simulations 
Once a simulation has been recorded with the Vissim interface, this function appears under 
Contents. A recorded simulation can be started here. If the playback is to be stopped, None 
must be selected. These simulations are included in a free project when a scout is published.  

When a simulation is selected for playback, it takes some time, depending on the size of the 
simulation, for the Vissim library objects to be loaded.  

 TippPursuit mode is also available in a simulation.  

5.2.4. Points of Interest (POI) 
POIs are available under Content only if they have been set beforehand in interaction with the Builder Control 
Center. Setting is only possible if ONE Scout project and ONE instance of the Builder Control Center are open with 
the same project loaded.  For this, it must be activated in Scout under Settings > Allow external communication.  
At the beginning, a viewpoint of the future POI must be recorded under Tools > Record Path > Viewpoint, which 
must be given the same name as the POI later. Then the Builder Control Center is opened and the settings for the 
POI are made. (see Builder manual chap. 5.3.2.) 

5.3. Tools 
The submenu summarizes various functions for interaction and query with the 3D data of the Scout. 

5.3.1. Info 
The query system “Info” facilitates the delivery of attribute information and meta information of 3D 
objects. Once the mode is activated, the following information about any object indicated by the 
mouse cursor is delivered, if available: 

Position 

• X / Y / Z: 3D coordinates in the position reference system of the input data 

• H: Current viewing height above the ground (only with Static terrain data class) 

Object Info 

• Scene Name: Identification of the data packet from the preceding Scout preparation (see 
Manual of the CityGRID® Builder) 

• Model: Name of the CityGRID® model where the units come from 

• ID: UnitID of the CityGRID® Unit 

Attributes 

• Possibly existing CityGRID® attributes of Units. 

A recording of clicked units can also be made by this Info mode. These recordings can subsequently be imported 
into the CityGRID® Modeler, as a list in the warning window. In this way building models can be tested efficiently 
within a model by Scouts. If a building must be delivered for an interactive correction in the Modeler, it will be 
entered in the Info list by clicking and then loaded in the Modeler for the subsequent correction. 
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The  button starts the recording mode. Once this mode is running, the image section of the 3D scene cannot be 

changed anymore, because the mouse cursor is now exclusively needed to identify the building models.  

interrupts the recording of the list and allows a change of the 3D viewpoint. Another click on  continues the 

recording. To stop the recording, click the  button again. The adjacent text box allows setting a comment for an 
easier and better identification of the clicked point in the Modeler. The text can be adjusted at any time to certain 
particular requirements and is effective immediately at the next recorded point. 

Recorded points are stored per started recording in the directory of the Scout under the path Content\Data\SuGu 
and always carry the designation "Info_current date/time” (e. g. Info_2018-05-28_03-31-14.xml). In case of 
multiple records, each record gets an individual XML file, while pausing a recording means, that all the following 
points are still written into the same descendant XML until the recording itself is stopped. 

5.3.2. Shadow 
In each CityGRID® Scout scene there can be introduced an active light source to perform shading 
studies. By default, the scout starts with the so-called ambient light, which ensures that all the 
surfaces of 3D objects are evenly illuminated. 3D objects begin to interact with the light source 
and to change their appearance by activating the light system. Lighted areas appear brighter, while 
shaded areas are shown as dark. 

 

Note: To determine the position of the sun, the geographical coordinates have to be specified through the 
Builder Control Center, by means of the Config page. Ideally, the center of the entire project area is used as 

reference point. If the specification of the geographic coordinates remains undone the shadow simulation 

cannot provide accurate results because the default position is that of Vienna. 

The selection list Mode allows the specification of the type of light source and the associated type of shading: 

• None:  

Disables all light sources except for the ambient light. The surfaces of the 3D bodies appear evenly lighted 
and equal from all sides. This does of course not include texture images that already contain a shading in 
the image content! 

• Shaded:  

There is introduced a light source in the 3D scene and aligned in accordance with the specified 
geographical coordinates. Lighted areas appear brighter, the far sides darkened. By this setting, the 
contrast is intensified, whereby the depth impression of the shown model is improved. 

• Soft:  

Operates analogously to Shaded but the 3D bodies also cast drop shadows in the 3D scene now. Of 
course, the shadow also takes into account all the included 3D scene objects and is reproduced 
according to their forms. The drop shadows are made semi-transparent in this Soft mode and are not 
reproduced with sharp shadow edges. 

• Hard:  

Operates analogously to Soft with the difference that the shadows are much darker and the shadow edge 
is drawn as a hard line. In this mode, the contrast between light and dark areas is the strongest of all 
possible light-settings. 

The exact time of shading can be specified via the input fields Date and Time. The format for the date follows 

the pattern day - month - year, the format for the time is hours - minutes. The button   opens a calendar, 

the button  sets the time on the current system time of the computer. The time is also infinitely variable 
using the slider. 

The checkbox Daylight Saving Time indicates whether the one-hour shift at the specified date needs to be 
taken into account or not. 
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5.3.3. Measure  
Measure starts a tool that allows the retrieval of coordinates, distances, angles and areas in the 3D 
world. The measurements can be recorded and output as an XML file. 

To start a measurement, click at any point in the 3D scene to define the starting point. The tip of the 
mouse cursor is the respective endpoint of the measurement. Depending on the measurement mode at the 
runtime, ratios of the measurement are released directly in the 3D window and in the output window of the 
measuring tools respectively. A double click ends the current measurement. A right-click facilitates the deletion of 
all measurement results in the 3D window. 

 

tip: Using the left shift button activates a snapping mode which only allows the selection of triangle 

vertices. The pressed Y button restricts the object snap to triangle edges. 

While the running measuring tool, the Scout highlights every hit building area (triangle) to provide the user with 
feedback about the currently active 3D object. It should be noted that only objects with a predefined distance to 
the current position in the 3D space are included in a measurement. Too far away objects are excluded from the 
measurement. 

 

tip: In order to nevertheless include distant objects in the measurement, the 3D cutout can be changed 

in the opened measuring tool. 

• Measurement Mode:  
Defines the type of measurement. The following modes are to choose: 

o Point: (P) 

Outputs the current position of the mouse cursor. Clicking the current position adds it to the 
measurement list. If a terrain model is present in the Scout, the parameter "h" informs about the 
relative height above ground. 

o Distance: (D) 

Determines the Euclidean distance between two measuring points. The first click specifies the 
start point, the second defines the target point. The distance between the points will be 
immediately issued and registered in the measurement list. 

o Angle: (A) 

Allows the measurement of angles in a triangle spanned by three clicks. The angles are output in 
degrees and immediately displayed at each triangle point. 

o Path: (G) 

Allows the determination of distances, including intermediate points. With each click, the 
measured distance gets extended and both the total length and the length of the respective 
segment are displayed. A double click ends the distance measurement. 

o Area: (F) 

Provides the facility to measure 2D surfaces. With each click, the measured area gets extended. 
A double click ends the range measurement. 

• Marker:  
The width of the measurement lines and the diameter of the ball at the measurement position can be 
determined with the slider. 

• Tag:  
The text box allows the setting of an arbitrary label for the measurement. The registered name is set in the 
XML file and can serve as an identifier of the measurement. 

• Lock camera movement:  
Freezes the current 3D cutout and prevents an inadvertent shifting. This option must always be turned off 
in the measuring-tool before a change of view. 
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tip: When closing or opening the measuring-tool, this option is also disabled. 

• Use Terrain Data Only: 
Restricts the measuring strictly to terrain models (data of the class static terrain) and ignores all other 3D 
objects in the Scout project. 

Button Functionality 

 

Save 

Stores the completed measurement and identifies it with the name in the entry field. New 
measurements are automatically stored in the file as long as no new file name has been set. 

 

Discard 

Deletes the entire measurement. This has no effect on already stored measurement results in XML. 

5.3.4. Digitizer (Path Recording) 
The 3D scene in the CityGRID® Scout can be controlled individually by the user and allows viewing 
the 3D virtual world from arbitrary angles. But sometimes it is also necessary to take pre-defined 
routes to put the attention on different aspects of the shown contents. Such an animation can also 
be used when the 3D scene is not being recorded interactively right now and the impression of a 
static image should be avoided. The menu item Digitizer offers the possibility to define such camera 
animations or fixed viewpoints. 

The menu offers several options to set camera animations. The selection of the applied creation method is defined 
via the selection list Recording Mode. The following modes are available: 

• Manually: 
From a series of sequentially flown views of the Scout, key images (key frames) are created and 
automatically connected by means of the smoothed path. The key frames can be set completely 
individually and the animation time between the keys can be specified via the menu. 

• Rotation:  
Based on the current 3D position in the Scout a rotation is performed on the spot. The duration of the 
rotation can be adjusted. 

• Around: 
By specifying a focus point (target) and the actual camera position, a round trip around the target point is 
framed. The specification of the time for one round determines the airspeed. 

• Real Time: 
The camera animation records the current movement in the 3D world, thus allowing the recording of a 
real-time flight. 

 

Note: The recording modes for camera animations can also be interconnected to create complex motion 
sequences. For this, the appropriate recording mode and the time duration have to be selected during the 

creation of the animation and the necessary keys must also be set. The Scout automatically adds these 

determined sequences to a homogeneous animation. 

• Viewpoint:  
The current view is saved as a focal point and can be called up again anytime. 

After the recording mode has been set, the definition of the animation itself happens via the recording parameters. 
As mentioned before the animation is framed by using key images (key frames or keys). The procedure here is 
always: 

1. Approaching the desired position in the Scout 
2. Aligning the angle of view 
3. Clicking the button to add / change the keyframe. 

To set keys, the following buttons are available: 
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Button Functionality Recording Mode 

 

Add 

The active viewpoint is added to the end of the existing animation. 
Manually,  

Rotation, 

Around 

 

Insert 

The active viewpoint is inserted after the set key image on the slider 
Keys (see below). 

Manually 

 

Replace 

The active viewpoint replaces the set key image on the slider Keys (see 
below). 

Manually 

 

Clear 

The set key image on the slider Keys (see below) is removed. 
Manually 

 

Start 

The recording of the flight path in real time is started. 
Real Time 

 

Target 

The current 3D position of the Scout is defined as the focal point for the 
round trip. 

Around 

 

Beside the key images, the time sequence thereof and the indication of the total time duration of the animation 
sequence respectively, is of crucial importance for the success of the camera flight. The time span between the 
keys is determined via the input field Time (s). Depending on the selected recording mode, the labeling of this 
parameter varies, as well as the predetermined time value. The recording length can be specified explicitly for the 
modes Rotation and Around, but in the case of the mode Manually predefined time interval and the covered 
distance in the Scout are crucial for the airspeed. 

 

tip: Only increasing the time interval does not necessarily result in a slower flight, as the interval just defines 
the margin between adjacent key images. Even if the keys lie far apart, a fast flight may still be necessary 

in order to complete the course within the predefined time. 

 

Note: The time interval can be set manually in the recording mode, individually for each key image. In the 

other modes, predefined times always count for the entire shooting sequence. 

In the case of manually recorded paths or a real-time recording, a connection of the last key image with the start-
up image can be inserted automatically by setting the option Close animation path. Thus, the animation can run in 
a loop without visible bounding at a further pass. 

 

Note: Close animation path also uses the specified time interval to come back to the starting frame. If 

starting point and target point are far apart a sufficient time period is to ensure. 

The controls for the command-group Keys give conclusion on the currently displayed key image, or allow access 
to certain key frames. Using the slider allows heading sequentially for all existing key frames. This facilitates 
changes of the time interval, or shifts in position via the recording buttons (see above). In the text boxes below the 
slider the currently active key image (Active Key) is cited, as well as the animation time (runtime) to this key image. 
Animation Length determines how long the entire animation will actually last. A change of time affects all key 
images proportionally. 

 

Note: By using this parameter the user can influence the global playing time, and thus the animation speed. 

Increasing the animation time provides a slower airspeed, a shortened duration provokes faster flights. 

Button Functionality 

 

Preview 
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The current animation will be played in preview mode. The path is not saved yet, and is typically 
being processed right now. 

 

Save 

Saves the created animation and labels it with the specified name in the entry field. If the name is 
already taken, the current time is appended: Around_2018-05-28_03-31-14 ". Renaming is 
currently only possible via the Builder Control Center, on the Config page. (see Manual of the 
CityGRID® Builder) 

 

Discard 

Deletes the entire animation with all its key images. 
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5.3.5. Renderer 
The 3D Scene of the CityGRID® Scout can be released in the form of still images or a series of frames 
for a downstream film production. The corresponding functions are bundled in the menu item 
Renderer. A precondition for the output of individual images, which even can be summarized as a 
film if desired, is the existence of a camera animation. The Scout does the path once and completely 
and generates 25 frames per second, in the desired image dimension. 

Via the group Contents it can be determined which parts of the 3D scene shell be output as (individual) images. 
The selection list Image Sequence lists all existing camera animations defined earlier via the menu item Digitizer 
(see 5.3.4)  or the 3D Studio Builder (see Manual of the CityGRID® Builder). Single Image, however, displays all 
viewpoints that are set in the Scout project. In addition to that, the entry Current View is present as the first list 
entry in order to render still images even without explicitly placed viewpoint. 

 

Note: If exactly the same view should be rendered more than once, for example to show different planning 

conditions, setting a viewpoint is advised, because otherwise it won’t be possible to adjust exactly the same 

view again. 

The Rendering mode provides different methods to save the previously specified contents as an image. 

• Preview:  

The default calculation of the camera animation is an image per second. This mode is intended for a quick 
test run of the rendering process to detect possible incorrect settings prior to a time-consuming full 
rendering. The output is not suitable for a continuing video production! 

• Normal: 

Generates 25 frames per second of the preset camera flight. Here, the reloading happens exactly the 
same way as in the Scout, and is therefore also visible in the video. 

• Detailed: 

In this mode, the Scout arranges that all data are loaded in the 3D window regardless of their distance 
before the image is rendered. Hence, no reloading effect is visible in the video. This mode provides the 
highest possible quality level of the image output, but also requires the most time. 

 

Note: In order to ensure the highest possible image quality and flexibility of the rendered video, the Scout 

produces a series of individual images, which can then be further processed into high-quality videos with 
the appropriate editing software. When rendering, it is deliberately avoided to display logos or labels, as 

these objects can be integrated as part of the post-processing of the rendering. 

 

Note: While the rendering process, the Scout must remain in focus (as active application), otherwise the 

rendering will be stopped. For a time-consuming rendering, it is therefore advised to use a separate 

computer on which no further work is carried out. 

The list Picture Size provides some common image dimensions as default, but also allows a user-defined setting 
of the image resolution by specifying the pixel values for image height and image width. In the predefined image 
sizes these values are not changeable. 

Under the heading Other optional features are listed that can be taken into account when rendering, if necessary.  
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• 360°:  

The rendered frames are views of the shooting position in all directions (equirectangular projection). 
Composed to a video, a clear 360 ° view is offered during the ongoing film. A particularly intense 
impression of such a video can be achieved by using VR glasses. 

 

Note: Rendering of 360 ° videos is only possible with video cards that offer a VR support. 

 
• Stereo:  

Generates a second slightly offset frame of every 360 °-frame to produce a stereoscopic impression at 
the runtime. Resultant films have even better 3D impression. For the preparation of such videos the used 
editing software must of course be able to process such data. In addition to that, the preparation time is 
higher than with conventional 360 ° rendering. 
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5.3.6. EasyGIS 
The so-called CityGRID Analyzer is located under this point. This makes it possible to create a difference image 
between a point cloud and matching CityGRID buildings. The following preliminary work is required to use the 
Analyzer:Reduzieren einer klassifizierten Punktwolke auf die Gebäudepunkte 

• Create a point cloud scout project using FME Builder Writer –  
• CityGRID building as xml, of the same area 

To open the Point Cloud Scout, the installed Scout must be started (via Windows Start) and the corresponding 
project path to the calculated Scout directory must be set. Once the point cloud has been loaded, the appropriate 
CityGRID file with the building models must be loaded via point 5.3.7.Unter EasyGIS kann dann die Aktion 
eingestellt werden  

• Mode 

Expects the DifferenceModel editing mode for the Analyzer. The WebGIS editing mode has been specially 
developed for a customer and is no longer recommended. 

• Main Model 

The point cloud to be compared is expected to be the main model. If there are several point clouds in the 
project, the desired point cloud can be selected via the drop-down menu. 

• Secondary Model 

As a secondary model, the appropriate roof restitution is expected, which is available in the drop-down 
list after loading the corresponding file. 
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• Distance Color Map 

The threshold values for the difference image can be entered using the color selector. A minimum value 
(green) of 20 cm is recommended and then increased in 10 cm increments. In this way, points up to 20 
cm away from the roof evaluation are colored green. 

• Visbility 

For a clearer representation, it is recommended to hide the roofs (Hide Secondary Model).  

• Temporary Calculation Offset (cm): 

Recommended if a regular shift in the point cloud is known. Only necessary in exceptional cases. 

• Export Settings:  

The difference image can be exported as a tiled, georeferenced orthoimage during the calculation. The tile 
size can be set with Step. The images are stored in this directory with the current 
date:\Scout\Content\Data\SuGu\Analyzer 

 

5.3.7. CityGRID  
This function is only available for licensed scouts. It allows you to add CityGRID xml files, 
CityGML files or buildings to a CityGRID database connection  

• Source:  

Erwartet die Auswahl einer Datei oder einer Datenbankverbindung. 

• Dataset:  

Allows you to select one of several loaded files, or one of several models in a CityGRID database 

• Data to load:  

Enables filtering of the data to be loaded 

• Building:  all buildings are loaded 

o Roof only: only the roofs of all buildings are loaded 

• Terrain: only the terrain is loaded 

• Reset: the data is unloaded 

With the button Load CityGRID Data, buildings are added to the project. 

 

 

5.3.8. Vissim 
The Vissim interface for traffic simulations is started under Tools > PTV Vissim.  Prerequisite is 
an active Vissim license. 

The prerequisites for productive work are:  

- CityGRID with licensed Scout/Vissim interface 
- PTV Vissim license with the "COM interface" module“ 
- Both CityGRID and Vissim must be installed locally 
- - A published Scout with EPSG code 

To work with Vissim, the installed Scout application must be started (not via the published Scout.exe). With the 
published Scout, the recorded Vissim simulations can be distributed license-free. 

 

On the start screen, navigate to the project path that contains the ProjectStarter.ugp. In the open Scout project, 
you can then navigate to Tools - PTV Vissim via the main menu.  
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• PTV Vissim Project:  

Specify the path to the Vissim project to be connected to open Scout (.inpx file). 

▪ … opens an existing project 

▪ + New Vissim project is created, with all the default settings required by CityGRID 
(model names of the library objects supported by CityGRID).  

o The ViewPoint of the scene is selected in the Scout. View as steep as 
possible. 

o  Press + to create a new Vissim project (ideally in a subdirectory 
"Vissim" in the active Scout project), the name entered is transferred 
to the selection box as an option 

o Open project  opens Vissim at the location of the selected viewport 

 

 

Tip: You must save manually in Vissim. Saving in Scout has no effect in Vissim. Therefore, save for 

the first time directly after creating the project in the open and loaded Vissim. 

 

There are two ways to open a project that was created outside the interface: 

▪  Variant 1: Create a new Vissim project via the interface (+), which contains all the 
necessary default settings. In the Vissim project that is then opened, you can make the 
necessary settings via the menu item „File“ ->„ Read additive “ -> „ Mesh “  and read 
external data (for example OSM Data). All necessary content (routes, light signals, etc.) 
is taken from the project, but the content taken from the template in variant 2 should 
either not be imported or at least not overwrite the original data. 

The models supported by CityGRID are used automatically. In Vissim under "Lists" -> 
"Basic data" -> "2D/3D models" or "Lists" -> "Individual traffic" -> "Vehicle 
composition" you will find all models of road users supported by CityGRID 

 

▪ Variant 2: Load a third-party project directly in Scout (...), In this case, third-party 
models that cannot be displayed in CityGRID are also loaded automatically.  
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In Vissim, navigate to the CiytGRID folder via "File" -> "Read additive" -> "Mesh": 
C:\Program Files\CityGRID\Scout\Scout_Data\Models\templates and load one of the 
templates that specifies the correct models. The models must then also be changed in 
Vissim in the loaded project. (For example, for "Vehicle flows" model to "Standard". 

 

Note: It is possible to overwrite the model mapping file between Vissim and CityGRID. Please contact 

UVM support for this (this procedure is not recommended). 

 

• Vissim Version:  

Specifies the version with which a Vissim project is opened or created. An older project can be opened 
with a newer version, but not vice versa. 

Only the last three Vissim versions are supported. The version cannot be changed in a running Scout 
session. 

 

Note: The interface was tested with the following Vissim versions: 

Vissim 2023 (SP 16) 

Vissim 2024 (SP 11) 

Vissim 2025 (SP 05) 

In future service packs, there may be the rare case that an APIChange requires a hotfix of the 

Vissim/Scout interface. 

 

• Height reference 

Specifies how the Z coordinate is determined or how data can be changed in the 3D window.  

▪ Scout:  

All height information is calculated in Scout from an intersection with the terrain model; 
heights from Vissim are ignored. The road users are always set to the terrain and ignore 
the height information from Vissim. If data (points, segments or lines) are moved, they 
always remain on the terrain 

▪ Vissim: 

The absolute Vissim heights are adopted except for routes that are exclusively at 0. For 
these, a terrain intersection is made again. 

The road users follow the route and ignore the terrain heights. 
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The position of the data can be shifted, but their absolute height is retained. With 
LeftCtrl, the data can be moved in height and remain fixed in their position. RightCtrl 
sets the selected data to the terrain. 

 

▪ Hybrid: 

The absolute heights from Vissim are integrated as an offset over the terrain. This allows 
routes to be set above or below the terrain (e.g. parking garages/underground 
garages/underpasses). Road users follow the route and ignore the terrain heights. 

The position of the data can be shifted, but its absolute height remains unchanged. With 
LeftCtrl, the data can be shifted in height and remain fixed in their position. RightCtrl 
sets the selected data to the terrain. 

 

 

• Open/Close Project:  

Connects the Scout to the Vissim project. The Vissim application is started, and the selected project is 
loaded into Vissim. Also, the data from the Vissim project is loaded into Scout.  

Normal road axes have link numbers <10,000 in Vissim, connectors >= 10,000. Connectors always have 
a start and end position on the road axes that are connected by this piece. The adjacent points cannot be 
changed in Scout and are displayed in red.  

With the Send changes button, the new information is transferred to the Vissim project.  

• Mode: 

❖ Edit 
Here, edits can be made to the road axes and signal systems in the Vissim project and transferred to 
Scout with Get Changes. Road axes can also be edited in Scout and transferred to the Vissim project 
with Send changes. Traffic lights can also be moved in their position with a mouse drag at their base. 
An entire line can be moved by holding down the Shift key (segment points shown in red are never 
moved). 
Usable hotkeys:  

o Shift (left and right): Shifting an entire road axis 
o RightCtrl: Automatic setting of the selected geometry to the terrain 

(with height reference Vissim or Hybrid) 
o LeftCtrl: Move vertically (with height reference Vissim or Hybrid) 

 

 
 

❖ Simulate 
When all editing steps are completed, the Simulate option can be selected. The editable road axes 
are hidden. The Reset button lets the started simulation start again from the beginning. Simulations 

with height reference Scout or Hybrid are more computationally intensive and therefore potentially 
slower, as the height information has to be recalculated for each road user in each frame. 



 

 Manual CityGRID® Scout - Page 34 

 

CityGRID® 

       Scout 

 

Record Simulation: This option can be set to record the active simulation to be able to distribute it 
without a Vissim license.  
Simulation calculations per second: How many times per second should Vissim calculate simulation 
changes. Corresponds to the frame rate in Scout. Vissim itself offers a maximum of 20 calculations 
per second, default is 10 calculations per second. 
Simulation speed: Run speed with time-lapse effect. Default is 1 
Enable fast mode: Suppresses all output in the Vissim 2D window, speeding up simulation 
processes. 
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Interacting in the simulation: With the pursuit mode the user can set the viewpoint in a 
vehicle during runtime. To do this, pause, select vehicle with a mouse click when pursuit 
mode is active, and change the camera position by turning the mouse wheel (pursuit 

position, driver position with the vehicle model, driver position without vehicle model). Each of the moving 
models is suitable for this, including pedestrians. 

 

 

Tip: Pause the scene before activating pursuit mode and clicking on a vehicle. This makes it easier 

to "catch" a vehicle. 

 
❖ Playback 

• In the Playback section, a recorded simulation can be played back, renamed, or deleted using the 
corresponding buttons.  

- Recorded simulations: shows a list of all recorded simulations in this project. 

- Playback speed: speeds up or slows down the playback of a recorded simulation. 
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5.4. Settings 

5.4.1. Properties 
The submenu Properties lists various settings and parameters of the Scout itself, the used 
computer and the network. Primarily this window serves the debugging and development by UVM 
Systems GmbH. 

5.4.2. Performance 
This menu allows parameters to affect the appearance of the Scout scene. 

• Resolution: 
Lists various dimensions in which the Scout can be displayed. The contents of the list are 
depending on the supported resolution of the graphic card and the chosen display device. With the 
exception of the Window Mode, that starts the Scout as a free-floating Windows-application, each 
selected resolution starts the Scout in fullscreen mode. 

• Quality Distance: 
Determines the distance up to which the Scout data can be presented in the best possible quality. The 
higher this value is set, the farther away from the current focus of the Scout project 3D data are visible. 
However, this also increases the memory requirements. If the value is too high, the Scout recognizes this 
and reduces the setting automatically to a reasonable level. The start value of the quality range can be set 
via the Config page in the Builder Control Center (see Manual of the CityGRID® Builder). 

 

tip: When rendering videos, the quality range should be set to the maximum tolerated value of the 

computer. Under these conditions, a video can be created using the mode "Normal", in which the 
reloading processes are virtually imperceptible (see 0), but that can be created significantly faster 

in contrast to the mode "Detail". 

• Texture Quality: 
Determines at which level of quality (LoD) the textures are presented. The lower the setting, the lower the 
texture quality and also the amount of data to be transferred in the Scout. This parameter has a primary 
impact in online Scouts where it is about creating a balance between data transmission and display 
quality. At the start of the Scout an optimal setting is ascertained, but if required this setting can still be 
varied by using the slider. The values range from low (0) to medium (1), high (2) and fantastic (3). 

 

tip: The texture quality can also be determined at the start of a Scout by means of the parameter 

“Quality” (see 2.1).  

• Anti-aliasing: 
Controls the quality of the anti-aliasing algorithm to avoid the sawtooth effect in vector space. The higher 
the value is set, the sharper the edges seem. But a high smoothing value also requires a high processing 
power of the graphic card, which is noticeable in a decreasing repetition sequence of the rendered images 
(FPS, see 5.4.1) noticeable. A good balance between parameters is important therefore. 

• Texture Filter 
Determines the quality of the anisotropic texture filter, which is used by the graphic card. 

• Shadow Quality: 
Affects the sharpness of the object's shadow in the Scout project. The higher the value, the sharper the 
shadow edge, but also the higher the processing power. Excessive shade quality influences the repetition 
frequency of rendered images (FPS, see 5.4.1) and thus the performance of the Scout project. 

• Shadow Distance: 
Sets the range in which shadows of 3D objects are calculated at the runtime. The value is interpreted as 
a radius, starting from the current camera position in the 3D window. High values generate the shadow 
also from more distant objects, but reduce the performance due to the increased computational demands 
on the graphic card. 

• Vertical Synchronization: 
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Regulates the type of image structure on the display unit. The slider represents different modes, but says 
nothing about the quality of synchronization! For the fine tuning of a Scout the vertical synchronization of 
every display unit is to be set individually! 

 

5.4.3. Point cloud 
To adjust the point cloud representation in the Scout is the task of this submenu. Various methods 
for point size representation are summarized here. In order to display the point cloud data in the 
Scout, each point is represented as a geometry object (square), which is always oriented parallel 
to the image plane. 

• Point Size:  
Adjusts the overall edge length of the square. The value can be set continuously variable in the range of 1 
– 25 via slider. The values correspond roughly to pixel values. 

• Use adaptive point size:  
Activates a mode that varies the size of the points, depending on the distance of the current camera point 
of the 3D scene. Distant points are displayed smaller and close to the camera position located points are 
bigger. 

o Adaptive point size (far): Point size distant from the camera point. 

o Adaptive point size (close): Point size close to the camera point 

 

Note: The general point size also affects the settings of the adaptive point cloud representation. 

The values of “far” and “near” thus regulate the relative size change to each other, the general 

point size on the contrary regulates the overall appearance. 

• Invert Direction: 
Inverts the default setting of the adaptive point size representation. When this option is enabled, remote 
points are represented proportionally increased and near points accordingly decreased. 

5.4.4. Engine 
General functions and parameters of the current Scout application are summarized here. 

• Startup Settings  
Determines how the Scout is to be configured at subsequent launches. 

o Allow streaming in cellular networks: 
Defines whether an online Scout may retrieve data from the internet when connected via a 
mobile network from any provider (phone contract or prepaid card). Since the streamed data can 
account for large amounts of data very quickly, it is recommended to use online Scouts only via 
Wi-Fi or wired internet, when the internet connection is based on fair use basis or unlimited data. 

o Scout pauses in background: 
Instructs the application not to load data if the program is put in the background. This setting has 
particular impact on the use on mobile devices such as mobile phone or tablet. 

o Streaming alert every 25 mb: 
Displays a message on the Scout window as soon as 25 MB of data have been transmitted. The 
user is thereby informed of the resulting transfer volume, particularly on mobile devices (mobile 
phones and tablets). 

 
o Show on Startup: 

Announces all the information regarding these parameters described here every time the Scout 
is started. The user could thus explicitly set certain parameters to allow a conscious and one-
time streaming on mobile networks. If this option is disabled, the Scout starts with the preset 
options without asking the user explicitly. 
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Note: To make the parameters appear again at the start, this box is to be set again. 

• Device: 
Allows switching between different viewing devices. The list shows all devices that are ready-to-operate 
on the computer and are supported by the Scout. 

• GUI - Size: 
Allows to regulate the space requirement of the menu. All control surfaces as well as the font reduce the 
size in accordance with the selected setting. 

• Communication: 
Allows the exchange of data between the Scout application and other programs. 

o Allowing External Communication: 
This option is currently used in the Builder Control Center to take over current views as fixed 
viewpoints directly from a running Scout. Once this option is active, the Scout makes its position 
information available to other programs every second. 

 

Note: As the query and transmission of Scout data results in a loss of performance in the 
3D window, this option should only be enabled if necessary. By default, it is disabled for 

this reason. 

• Library Data  
Provides settings for Unity-based library objects that can be contained in the Scout. 

o Show Model Animation: 
Activates any possible movement pattern in the used library objects. For example, movements 
of the human-library can be prohibited. 

 

Note: “Show animations” has no effect on explicitly defined movements of the 3D Studio 
Builder, but is only effective for specially prepared library objects, which themselves 

already have animations.  

• Transparency: 
Provides a slider by means of which the transparency (see 5.2.2) of all objects that have been defined 
through the Builder Control Center and the Config page is set (see Manual of the CityGRID® Builder). The 
values can be set continuously variable from 10 to 90. The higher the value, the more transparent the 3D 
objects appear. 

5.4.5. Documentation 
Calls a link to the CityGRID® Scout Manual. The manual is provided as PDF on the homepage of 
UVM Systems GmbH. An internet connection is required to access the manual. 

 

5.4.6. About… 
Provides general information about the Scout application, such as the version number. 
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6. Error Processing 
The CityGRID® software is developed, tested and serviced by UVM Systems GmbH with the pursuit of accuracy. 
However, we cannot completely exclude errors during processing. 

If you want to send an error report, please include the following information / data: 

1. Description of the actions that led to the error. 
2. SuGu.log log file: you can find the log file under Scout\Content\Data\Sugu in your Scout project. 

 

Note: Please save this file immediately after the crash, as a renewed program start can lead to an overwriting of 

this file. 

Please send the error reports to: support@uvmsystems.com 

mailto:support@uvmsystems.com
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7. Contact 
 

 

 
 

UVM Systems GmbH 

www.citygrid.at 

www.uvmsystems.com 

 

http://www.citygrid.at/
http://www.uvmsystems.com/

